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Questions & Answers

» For GENERAL questions, please submit your question to 
the WebEx chat and please ensure that your questions are visible 
to all participants, because the host is not monitoring private chat to 
the host.

» For SPECIFIC questions, please reach out to the appropriate Data 
Mailbox as will be instructed closer to the end of this presentation.



Before we move on

» Today's webinar is being recorded for documentation purposes.
» The recorded video, script, and presentation materials 

will be uploaded to Data Reporting and Monitoring Webinar Series.
» The glossary and FAQs are also updated regularly every month.

https://www.dhcs.ca.gov/dataandstats/Pages/Quality-Webinar-Series.aspx


Webinar Topics

Amy Peterson, Chief 
Managed Care Data Support Section



Welcome! Tell Us About Yourself

Please introduce yourself in the chat:

» Your Role and Organization
» Topics you would like us to cover in future webinars

(What would be most valuable to you or your team?)



Medi-Cal Connect

Dr. Laura Miller
Medical Consultant II

Quality and Population Health Management



Agenda

» Medi-Cal Connect Overview
» Medi-Cal Advisor Engagement Overview

• Advisor Engagement Update
» Release 3 Anticipated Data Sources
» Medi-Cal Connect API Overview

• Risk Tier
• LMR

» Medi-Cal Plan Dashboards
» Longitudinal Member Record

• Care Management Capabilities



Medi-Cal Connect Vision & Key Features (1/2)

» To provide a data-driven business solution that supports whole-
person care by integrating information from trusted partners to 
support population health functions and allow for multi-party 
data access and sharing.  



Longitudinal Member 
Record (LMR)
» Purpose: Access to 

member-level data and 
health records

» Example Users: MCP 
Care Managers

Quality Dashboard
» Purpose: Performance 

monitoring through 
data analytics

» Example Users: MCP 
Quality Analysts

Risk Stratification 
Segmentation and 
Tiering (RSST)
» Purpose: Standardized 

risk tiering to identify 
members who may 
benefit from services 

» Example Users: MCP 
Care Managers 

Medi-Cal Connect Vision & Key Features (2/2)



Data Driven Solution from Trusted Sources (1/2)

» Medi-Cal Connect will aggregate health and social information
from many sources to support members and communities.



Data Driven Solution from Trusted Sources (2/2)



Q4 2024- Q1 
2025

Q4 2025 & 
Beyond

Medi-Cal Connect Timeline
Looking Ahead

Advisor
Engagement

DHCS 
Releases

MCP 
Onboarding

(Admins & Tech 
Reps)

MCP 
Onboarding 
Office Hours

Release 3
(July 18)

MCP Training

Additional 
Capabilities & 
User Groups

Q2-Q3 2025

These dates are tentative and subject to change.



Rollout Engagement Approach (1/2)
» Release 3 Rollout engagement will occur between March-October 2025. Level of 

engagement varies by role. Today’s meeting focuses on Advisor engagement updates and 
All Plan Engagement schedule.

» Reminder: Release 3 launches on July 18, 2025

Q3 24 Q4 24 Q1 25 Q2 25 Q3 25 Q4 25

Early Adopters

All Plan Engagement
Advisors

R3



Rollout Engagement Approach (2/2)

Name Objective Timeline
Early Adopters Medi-Cal Plans selected by DHCS leadership to provide input 

on and prioritize Medi-Cal Connect use cases and value 
propositions.

Jan 2024 – Feb 2025

Advisors Plans willing and able to commit resources to review 
and validate the service for the broader Medi-Cal Plan 
community. “Roll up your sleeves” role.

March 2025 – July 2025

All Plan 
Engagements

Socialize Medi-Cal Connect, including capability previews and 
onboarding expectations at existing venues to champion 
adoption with the broader Medi-Cal Plan community.

May 2025 – 
October 2025



Advisor Priorities

» Advisors will review and validate the following R3 capabilities for 
the broader Medi-Cal Plan community

Risk Stratification, 
Segmentation and 

Tiering (RSST)

Access & 
Permissions 

Administration

Care Management APIs & Data Sharing



Medi-Cal Connect Advisors: Progress Update (1/3)

Participants
» MCPs

• Health Net
• Health Plan of San Mateo (HPSM)
• Inland Empire Health Plan (IEHP)
• Kaiser Permanente
• L.A. Care

» BHPs
• California Mental Health Services 

Authority (CalMHSA)
• Orange County

» Staff Types Engaged
• Senior Leaders (i.e., CMOs, CIOs, and 

CHEOs)
• Medical Directors
• Care Management Directors
• Population Health Directors
• Data Analytics Directors
• Digital Initiative Directors
• Security Officers
• Clinical Informatics Managers
• Health Services Managers
• Population Health Program Managers
• IT Managers



Medi-Cal Connect Advisors: Progress Update (2/3)

Advisor Curriculum 
Risk Stratification, 
Segmentation and 

Tiering (RSST)
Care 

Management
APIs & Data 

Sharing
Access & 

Permissions

Compare DHCS RSST 
output as of 01/2023 to 
internal risk and care 
management activities 
performed in 2023. Report 
tiering alignment or 
differences. 

Review components of 
the longitudinal member 
record (LMR) that can be 
used for care planning 
and care coordination 
activities. 

Review API 
capabilities and 
understand 
expectations for 
connectivity, 
security, and 
consumption. 

Review workflows 
and associated 
responsibilities for 
administrators, who 
will manage access 
for users across their 
organization. 
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Level of Engagement
» We have facilitated eight working sessions to date including the Kick-off, 

Show-and-Tell, and five capability focused sessions across all topics. 
» Advisors are very engaged in session and offline

• Between 30-40 plan staff have attended each session
• We have captured 125+ questions across sessions

» Advisors want more opportunities to review onboarding guides, tech specs, 
and policy considerations

Medi-Cal Connect Advisors: Progress Update (3/3)



Release 3 Anticipated Data Sources



Anticipated Data Sources (1/4)

All Medi-Cal Claims Data 
(APCD-CDL File)
» Description: This source encompasses 

comprehensive claims data and provides a 
detailed view of services rendered, billing 
codes, diagnosis, and other claims-related 
information

» Key Data Points:
• Medical, dental and pharmacy claims
• Provider identifiers (NPI, first name, last 

name)
• Service dates
• Diagnosis and procedure codes

Supplemental Eligibility File
» Description: This source enriches the core 

eligibility data by adding detailed 
demographic and contact information, 
improving the accuracy and depth of member 
data

» Key Data Points:
• Member demographics (age, gender, 

race/ethnicity)
• DHCS Contact information (address, phone 

numbers, emails)
• Some data for specific programs or 

services (duals)

The following data sources will be available in Medi-Cal Connect as of Release 3:



Anticipated Data Sources (2/4)

Medi-Cal Connect Generated Data
» Description: This source will be a new data 

source upon launch by generating several 
member insights or member characteristics to 
support care coordination

» Key Data Points:
• Member Flags (e.g. likely eligible for ECM, 

Community Supports)
• RSST risk tiers
• Evidence of underutilization

Enhanced Care Management (ECM) and Community 
Supports (ECM/CS JSON File)
» Description: This source contains details on 

members enrolled in ECM and Community supports, 
including population of focus designation (i.e., 
experiencing homelessness, justice-involved, etc.) and 
service utilization

» Key Data Points:
• ECM and CS member enrollment details 
• ECM provider information 
• CS organization information 
• Services provided to members under ECM/CS 



Anticipated Data Sources (3/4)

Primary Care Provider (PCP) Assignment (PCPA 
File)
» Description: This source contains details about 

each member’s assigned PCP and relevant contact 
information to ensure that care coordination is 
optimized through up-to-date assignments

» Key Data Points:
• Member’s assigned PCP 
• PCP contact information (phone, email) 
• PCP practice location

Provider and Organization Data (274 File)
» Description: This source provides detailed data for all 

types of providers and organizations involved in the 
care of members, including care managers 

» Key Data Points
• Provider information (names, specialties) 
• Organization details (clinic, hospital, etc.) 
• Care manager or affiliated provider information 
• Provider office hours and availability
• Telehealth services offered 
• Languages spoken at the site 



Anticipated Data Sources (4/4)

CalFresh
» Description: This source 

contains information on 
members enrolled in 
CalFresh, including their 
enrollment status and 
related data

In-Home Supportive 
Services (IHSS)
» Description: This source 

provides details on 
members receiving IHSS, 
including their assessment 
data, medical claims, and 
assigned providers

Women, Infants, and 
Children (WIC)
» Description: This source 

contains comprehensive 
details on members 
enrolled in WIC 
programs.  This will be used 
for the RSST algorithm only 
in Release 3



Medi-Cal Connect API Overview (1/2)

» Medi-Cal Connect will have two external-facing APIs that enable DHCS 
to share member data in a standardized and secure manner. APIs include:
• Monthly Risk Tier: The ability for MCPs to retrieve monthly all-

member RSST Tiering data.
• Longitudinal Member Record (LMR): The ability to retrieve the LMR 

for assigned members.



Medi-Cal Connect API Overview (2/2)
Medi-Cal Connect Data Sources

All-Payer Claims Database Common Data Layout
(APCD-CDL)

Comprehensive claims data, including medical, 
dental, and pharmacy claims (i.e., services 
rendered, billing codes, diagnosis, and other 
claims-related information)

Supplemental Eligibility (SUME) Enriches core eligibility data by adding detailed 
member demographic and contact information

ECM/CS QMIR & JSON Comprehensive ECM and CS data, including 
encounters and providers or organizations 
involved in care. QMIR transitions to JSON in 2026

274 File Contains provider attribution data for medical, 
dental and behavioral health

Primary Care Provider Assignment (PCPA) Contain PCP assignment and 
contact information by member

Women, Infants, and Children (WIC) Contains enrollment and eligibility for the WIC 
federal assistance program

Medi-Cal Connect Data Source  



Data Sources by API
Data Category Source File(s) Description Risk API LMR API

Member &  
Member 
Demographics

• APCD-CDL
• SUME

Member data including personal ID, 
contact information, race and ethnicity, 
and plan or program attributions

X X

Eligibility • APCD-CDL
• SUME

Enrollment and coverage information 
for Medi-Cal, Family Planning, Access, 
Care and Treatment (FPACT), CCS, etc.

X

Claim & Encounters • APCD-CDL
• ECM/CS QMIR & JSON 

Billed events and encounters reported 
to DHCS
Includes medical, dental and pharmacy

X

Providers • ECM/CS QMIR & JSON 
• 274
• PCPA

Providers rendering care and a profile 
of each provider and provider 
organization as available

X

Member Flags • APCD-CDL
• SUME
• ECM/CS QMIR & JSON

DHCS-generated flags for populations 
of interest X

Risk Tiering • APCD-CDL
• SUME
• ECM/CS QMIR & JSON

DHCS-generated risk tiers
X X

Medi-Cal Plans will receive different data elements depending on the API (x).



API Data Flow and Architecture

External APIs are built on FHIR v4 
standards and offer both member-level 
and bulk retrieval mechanisms.

» STEP 1: MCPs make an API request
» STEP 2: The API request arrives at the 

DHCS API Gateway
» STEP 3: The request is then routed to 

the Medi-Cal Connect Intersystems API 
Gateway

» STEP 4: The Intersystems API 
Gateway responds to the API request.

» STEP 5: Data response is routed through 
the DHCS API Gateway to the MCPs 
(request originator)
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Monthly Risk Tier API Review 
(MCPs Only)



Monthly Risk Tiers API Specification

» Provides bulk access to risk tier data for members. 

» Available to MCPs only. 

• Returns member contact information and tiering information 
for all members.

• Member’s risk data will be returned based most current eligibility 
file processed in Medi-Cal Connect. 
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Longitudinal Member Record (LMR) 
API Review



Longitudinal Member Record (LMR) Specification

» Enables MCPs to access a 
comprehensive profile of 
members affiliated with their 
organization to support care 
coordination and risk 
assessment. 

» WIC Enrollment will not be 
used in Medi-Cal Connect in 
Release 3 for external users.
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Dashboards 



Key Medi-Cal Connect Dashboards (1/3)

» The below dashboards are available to DHCS users as of 
Release 2*.  The Quality Measures Dashboard will be available 
to Medi-Cal Plan users in Release 3.  Development is in 
progress and mock-ups will be shared with Advisors as part of 
engagement.

*Excluding RSST



Key Medi-Cal Connect Dashboards (2/3)

Condition Prevalence Dashboard
» Intended to provide insight into 

the prevalence of clinical conditions 
and related utilization of services.

» Users will explore and evaluate 
utilization metrics for subpopulations 
relative to selected comparison groups.

Quality Measures Dashboard
» Intended to analyze quality 

performance for a given calendar year 
and initiative.

» The dashboard may be configured to 
allow “drill downs” into member level 
data. 



Key Medi-Cal Connect Dashboards (3/3)

Health Equity 
Dashboard
» Intended to analyze 

and monitor existing 
knowledge about 
disparities for a given 
calendar year and 
Health Equity Key Area 
to support the 
evolving DHCS strategy 
for health equity.

RSST Dashboard
» Intended to track 

distribution of the 
risk tiers within the 
Medi-Cal program, 
including statewide 
averages, regional 
averages, population 
and MCP specific 
averages, and tiering 
thresholds for each 
subdomain. 

Care Management 
Demographics
» Intended to provide 

demographic data on 
members receiving 
ECM and CS services.



Quality Measures Dashboard

This dashboard 
will analyze quality 
performance for 
a given calendar year 
and initiative. The 
mock-up to the 
right is the DHCS 
view. Additional 
dashboard mock-ups 
with MCP views will 
be shared at a later 
date.
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Longitudinal Member Record (LMR)



Longitudinal Member Record & Care Management 
Capabilities 

Key care management 
features are available in 
Release 3. Additional 
features may be included 
in future releases as 
prioritized by DHCS.
» Member Summary 

• Overview of member’s 
health history

» Member Information
• Contact and 

Demographic 
Information​

• Health Plan Enrollment

» Diagnoses
• Record of conditions 

including chronic 
conditions​

• Provider visits 
associated with a 
condition

» Care Team Information
• PCP Information ​
• ECM or CCM Care 

Manager Information​
• Other frequently seen 

providers

» Claims
• Inpatient​
• Outpatient ​
• Pharmacy ​
• Dental ​
• Behavioral ​Health

» Risk Profile  
• Risk domains ​
• Quality measure 

outcomes
» Programs and Services

• Eligibility​
• Enrollment 



LMR Mock-Up: Member SummaryLMR Mock-Up: Member Summary



LMR Mock-Up: Risk Profile LMR Mock-Up: Risk Profile



LMR Mock-Up: Programs and ServicesLMR Mock-Up: Programs and Services
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Next Steps



Potential Upcoming All 
Plan Engagements All Plan Meeting Venue  Venue Description & 

Frequency

CalAIM MCP TA Calls
Monthly meeting with all 
MCPs on fourth Thursday of 
month, 3-4:30pm.

DHCS/LHPC/CAHP 
Meeting

Weekly DHCS-led meetings 
with associations.

CEO/DHCS Meeting Quarterly MCP CEO Meetings

CMO/DHCS Meeting Quarterly MCP CMO Meetings

Data Reporting and 
Monitoring Webinar

Data reporting and monitoring 
meeting with DHCS and MCPs

» Topics include Medi-Cal 
Connect capability previews, 
onboarding expectations 
and engagement updates. 

» Are there additional  commu
nication venues we 
should consider?
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Comments and Questions?



Resources



Behavioral Health Managed Care
Resource Emails Topics

CountySupport@dhcs.ca.gov
Behavioral Health Managed Care Plan Annual Report

Behavioral Health 1915 (b) Appeals and Grievance 
Report

NAOS@dhcs.ca.gov Behavioral Health Network Adequacy

MEDCCC@dhcs.ca.gov
Behavioral Health Short Doyle Claims

Short Doyle Claim Denials/Recoupments

mailto:CountySupport@dhcs.ca.gov
mailto:NAOS@dhcs.ca.gov
mailto:MEDCCC@dhcs.ca.gov


Dental Managed Care

Resource Emails Topics

DMCdeliverables@dhcs.ca.gov 274 Dental Provider and 837 Encounters

Dental@dhcs.ca.gov Medi-Cal Dental Information

DentalManagedCare@dhcs.ca.gov Dental Managed Care

mailto:DMCdeliverables@dhcs.ca.gov
mailto:Dental@dhcs.ca.gov
mailto:DentalManagedCare@dhcs.ca.gov


Programs for All-Inclusive Care for the Elderly 
(PACE) Organizations

Resource Emails Topic(s)

PACECompliance@dhcs.ca.gov
Program for All-Inclusive Care for the 
Elderly (PACE) Plan policy and 
compliance questions

pacecontractmanager@dhcs.ca.gov
• SFTP Access and changes
• PACE Organization onboarding

mailto:PACECompliance@dhcs.ca.gov
mailto:pacecontractmanager@dhcs.ca.gov


Medical Managed Care Program
Resource Emails Topics

MCQMD@dhcs.ca.gov

• MCPAR Critical Incidences
• CMS Requirement for Managed Care Program Annual Report 

(MCPAR)
• Primary Care Provider Assignment (PCPA) Policy
• Managed Care Program Data (MCPD)

MCBHOMD@dhcs.ca.gov
Managed Care Plans send Managed Care Plan Annual Reports to 
DHCS for each delivery system by email to this address

MMCDPMB@dhcs.ca.gov
• General Inquiries
• Medi-Cal Managed Care
• Managed Care contract managers

MCODReadiness@dhcs.ca.gov
• SFTP Access Set Up
• Plan Onboarding
• Managed Care Contracts

mailto:MCQMD@dhcs.ca.gov
mailto:MCBHOMD@dhcs.ca.gov
mailto:MMCDPMB@dhcs.ca.gov
https://www.dhcs.ca.gov/services/Pages/Medi-CalManagedCare.aspx
mailto:MCODReadiness@dhcs.ca.gov


Technical Support

Resource Emails Topics

DataExchange@dhcs.ca
.gov

Technical Assistance with 
Submitting a JSON file

DHCS Documentation Center 
access
Excel Data Template 
questions that Data 
Collection Unit (DCU) 
handles

Resource Emails Topics

EDIMDataSupport@dh
cs.ca.gov

Technical Questions 
related to Data Feed, 
ECM/CS/CCM JSON

CalAIMECMILOS@dhc
s.ca.gov

ECM/CS/CCM JSON 
Exchange

Monitoring and 
compliance oversight of 
Managed Care Plans' 
implementation of the 
new ECM/CS benefits

MCDSS@dhcs.ca.gov
Data Reporting and 
Monitoring Webinar 
Technical Support

mailto:EDIMDataSupport@dhcs.ca.gov
mailto:CalAIMECMILOS@dhcs.ca.gov
mailto:MCDSS@dhcs.ca.gov


Next Webinar Preview

» For June 2025, we will focus on Encounter Data 
Quality Improvement Efforts: Part Three.

» Meeting Information  
• Date: June 25, 2025
• Time: 10 a.m. to 11 a.m.  



Thank you!

Please send any questions and comments about the webinar series or this 
event to MCDSS@dhcs.ca.gov

mailto:MCDSS@dhcs.ca.gov
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